
  Creating Mouths
Animation Pro includes a 'Mouth Creator' that allows you to create the mouths that will  work with its automatic lip-synching
functionality.  For more details on Animation Pro's lip-synching capabilities, please refer to the 'Audio' topic (left).  To create a new
mouth, press the         button at the top of the screen (you will fnd this button on most of the Animation Pro screens) and then
select 'Create a Mouth'.  Topics:

Mouth Projects
   Creating an Mouth Project
   Opening an Mouth Project
   Importing a Mouth Project

Mouth Creator Screen Overview
Mouth Shapes

Choosing a Colour
   Selecting a Solid Colour
   Selecting a Linear Gradient
   Selecting a Radial Gradient
   The Colour Picker

The Colour Palette

Layers
   Selecting a Layer
   Hiding a Layer
   Changing the Opacity of a Layer
   Removing the Content from a Layer
   Removing the Content from the Selected Layer
   Removing the Content from All Layers
   Rearranging Layers
   Merging Layers

Adding Images
Distorting the Active Canvas Layer
Blurring the Active Canvas Layer
Editing Tools Overview

The Brush Tool

The Fill Tool
   Filling with Solid Colours
   Filling with a Linear Gradient
   Filling with a Radial Gradient
   Fill Options
      Tolerance
      Preserve Alpha
      Replace Colour
      Fill Void

The Eraser Tool
The Transform Tool

The Selection Tool
   Selecting Content
   Deselecting Content
   Cut
   Copy
   Paste
   Paste Options
      Scaling the Pasted Content
      Rotating the Pasted Content
      Flipping the Pasted Content
      Setting the Opacity of the Pasted Content
      Moving the Pasted Content
      Committing a Paste Operation

The Lighten Tool

The Darken Tool
The Tint Tool

The Shapes Tool
   Adding Circles or Ovals
   Adding Squares or Rectangles
   Adding Lines
   Adding Curves

Undo
Testing a Mouth
Saving the Currently Selected Mouth

Exporting Mouths
   Other Output Options
   Cropping and Reducing the Image Size

The Cursor

Antialiasing
   Turning Antialiasing On and Of

Mouth Creator Options
Copying Mouth Shapes
Setting an Onion Skin



  Mouth Projects

Creating a Mouth Project

Whenever you open the 'Mouth Creator', Animation Pro will display the 'Mouth Projects' fle manager.  If you haven't created a
'Mouth Project' before, the list of mouth projects will be empty and the         button will fash.  Press the button to create a new
mouth project:

Press this button to
create a new mouth

project.



Animation Pro will prompt you to name your new mouth project.  Enter a name and press the         button:

Enter a name for your project

Press this button to create
the project

Press this button to cancel



Opening a Mouth Project

Tap on a mouth project to open it:

For more information about the Animation Pro fle manager, please refer to the 'File Manager' topic (left).



Importing a Mouth Project

Mouth projects previously shared to Apple ‘Files’ may be imported by pressing the ‘Import’ button at the top of the fle manager as 
shown below: 

For more information about the Animation Pro fle manager, please refer to the 'File Manager' topic (left).



  Mouth Creator Screen Overview (1)

Go back to the
previous screen

Open or create a
new mouth project

'Remove' menu

Tool options.

This will change
based upon the

editing tool.

'Output' menu 'Options' menu

Help – this
document

Mouths.

The currently
selected mouth

will have a
blue border

Press to test
your mouth

Turn the cursor on or
of (drawing tools

only).

Turn anti-aliasing
on or of.

Manipulate the canvas
layers

Apply efectsAdd an image



  Mouth Creator Screen Overview (2)

Canvas.

Use two fngers to
move the canvas.

Use pinch-to-zoom to
zoom in and out.

The currently selected
colour for the current

tool

Rotate to select a
brush size (drawing

tools only)

Reset pan/
zoom

Select to draw with
an Apple Pencil

Select to draw with
your fnger

Editing tools

Edit the colour palette

Add the currently
selected colour to the

colour palette

The colour palette



Mouth Shapes

A mouth is essentially a collection of 12 different images representing different mouth 'shapes'.   Animation Pro automatically
chooses the most appropriate image (i.e. shape) based upon the sound, and the volume of the sound, being made when lip-
synching is turned on.  

Whenever a new mouth project is created,
all  twelve images will  be blank.  As shown
right, however, Animation Pro will  display a
'ghost image' for each mouth to give you an
idea about the 'shape' required.

To  start  editing  one  of  the  mouth  shapes,
tap on one of the twelve thumbnail images.
The selected mouth will be highlighted with a
blue border. 

Closed mouth
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General Sound
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General Sound
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Choosing a Colour

The frst thing that you'll most likely want to do before you begin drawing is select a colour.  All of the editing tools (at the top of the 
screen) can be assigned a different colour.  So the 'brush' tool can have a different colour to the 'fll' tool and the mouth creator will
remember the settings.

To  select  a  colour  for  the  currently
selected  tool,  tap  on  the  'colour'
button (as shown right).  This button
will  change colour based upon your
selection.

This  will  display  the  colour  options
(as shown right).

Colours may by solid (a single colour)
or  gradients  (a  transition  between
two different colours).  Gradients can
also be linear:

or radial:

Colours may also be assigned a level
of opacity.

Colour options

The 'colour' button



Selecting a Solid Colour

Press this button
to select a solid colour

Tap anywhere on the colour
swatch to select the solid colour

Tap anywhere on the colour
gradient to select a lighter

version of the current colour

Tap here to toggle between
the colour swatch and

RGB (red, green, and blue)
colour selection dials:

A preview of the selected colour

Rotate the dial to set the
opacity of the colourTap here to fnely adjust the

level of opacity



Selecting a Linear Gradient

Selecting a linear gradient requires two colours to be
selected:

1. Press the 'Gradient' button 
2. Press the 'Linear' button
3. Press the 'Colour 1' button and choose a colour
4. Press the 'Colour 2' button and choose a colour

Here,  the  'preview'  represents  the  drawing  canvas.
So, based upon the example (right), colour added to
the  extreme  left  of  the  canvas  will  be  orange  and
colour added to the extreme right will be purple (with
a  smooth  transition  from  orange  to  purple  for  any
point in between).

You can change the size and angle of the gradient by
dragging your fnger across the preview:

Tap anywhere on the colour
swatch to select a colour

Tap anywhere on the colour
gradient to select a lighter

version of the current colour

A preview of the selected colour

The opacity will be applied to
the entire gradient.



Selecting a Radial Gradient

Selecting a radial gradient requires two colours to be
selected:

1. Press the 'Gradient' button 
2. Press the 'Radial' button
3. Press the 'Colour 1' button and choose a colour
4. Press the 'Colour 2' button and choose a colour

Here,  the  'preview'  represents  the  drawing  canvas.
So, based upon the example (right), colour added to
the middle of the canvas will  be orange and colour
added  to  the  extreme  right  will  be  purple  (with  a
smooth transition from orange to purple for any point
in between).

You  can  change  the  position  and  radius  of  the
gradient by dragging your fnger across the preview:

Tap anywhere on the colour
swatch to select a colour

Tap anywhere on the colour
gradient to select a lighter

version of the current colour

A preview of the selected colour

The opacity will be applied to
the entire gradient.



The Colour Picker

Sometimes it  can be useful  to  be  able  to
select an existing colour from the canvas.

1. Press the            button

This will  turn 'colour picking mode' on and
the button will fash.

2. Touch anywhere on the canvas to pick
 the colour beneath your fnger-tip.

3. Press the            button

This will  turn 'colour picking mode' off and
the button will stop fashing.

Useful Hints

For precise colour selection, zoom in on the
area  of  the  canvas  you  are  interested  in
before turning 'colour picking mode' on.

The colour will  be selected from the active
canvas layer.  So please ensure that you've
selected  the  correct  layer  prior  to  turning
'colour  picking  mode'  on   (see  'Layers',
below, for more details on layer selection).

Tap this button to turn
'colour picking mode' on/of



The Colour Palette

Whenever you create a new mouth project, Animation Pro will provide a basic 5 colour palette to get you started:

You can add as many colours as you like to the colour palette, please see below...

Basic colour palette – tap on
a colour to select it



Adding a Colour to the Colour Palette

There are a couple of ways to add a colour to the colour palette:

1. Select a new colour:      2. Press the        button (as shown below):

OR (see next page)

Tap to add the colour
to the palette

Tap and select a colour

Palette colours will
be shown here.

You may add as many
colours as you please.

Swipe left and right
with your fnger.



Adding a Recently Used Colour to the Colour Palette

1. Press the         button to open the palette panel:                   2. Select one of the recently used colours and press
          the         button as shown below: 

Please note:

Recently used colours will appear in the palette panel as colours are actually used in the Mouth Creator.

Tap to open the palette
panel

Tap to add the colour
to the palette

Palette colours will
be shown here.

You may add as many
colours as you please.

Swipe left and right
with your fnger.



The Palette Panel

You can manage all of your palette colours via the palette panel.  Press the          button at the top of the screen to open the 
palette panel:

These are the palette colours that 
will be displayed by the 

Mouth Creator

These are colours that have been
recently used

Use these two arrows to move
the selected palette colour

Press to remove all
colours from the palette

Press to add the currently 
selected colour to the palette

Press to remove the currently
selected palette colour from

the palette

The currently selected palette
colour will have a white border

The currently
selected colour

The palette panel.
Tap on any colour in this panel

to select it for use with
the current tool.



Layers

The canvas is made up of 5 separate layers.  Its kind of like having 5 transparent pieces of paper stacked on top of each other.
You can draw on each of them independently to produce a single image i.e. the view of the stack from above.  Furthermore, you
can  take  those  pieces  of  paper  and  rearrange  them,  remove  one  or  more  of  them  or  even  change  their  level  of
transparency/opacity.

Selecting a Layer

1. Press the           button to 
 display the layer panel (right).

2. Tap on a layer to select it.

The selected, or active layer, will be
shown with a blue border.

The  editing  tools  will  target  the
selected layer only.

The currently selected layer

Tap here to display
the layer panel



Hiding a Layer

Sometimes it can be useful to hide a layer so that you can see,
and work on, another layer beneath.

1. Press the         button to display the layer panel (right).

2. Press the           buttons to hide the desired layers.

When layers are hidden, the buttons will change to look like this:

You can tap on these buttons to  make the layers  visible  once
again.

Tap here to display
the layer panel



Changing the Opacity of a Layer

1. Press the         button to display the layer panel (right).

2. Drag the slider for a given layer to adjust its opacity.

Tap here to display
the layer panel



Removing the Content from a Layer

1. Press the         button to display the layer panel (right).

2. Press the 'Edit' button at the bottom of the layer panel.

3. Press the          button next to the layer that you wish to
 remove the content from.

Tap here to display
the layer panel



4. Confrm the removal by pressing the 'Delete' button:

Removing the Content from the Selected Layer

A quick way to remove all of the content from the active layer is to
select 'Image from Current Layer' from the 'Remove' menu:



Removing the Content from All Layers

1. Press the         button to display the layer panel (right).

2. Press the 'Reset All' button at the bottom of the layer panel.

3. Select 'Yes' when prompted.

Tap here to display
the layer panel



Alternatively, you can:

1. Press the          button at the top of the screen to open the 'Remove' menu

2. Press the 'Everything' button



Rearranging Layers

1. Press the         button to display the layer panel (right).

2. Press the 'Edit' button at the bottom of the layer panel.

3. Drag layers up and down using the             handles:

4. Press the 'Cancel' button at the bottom of the layer panel 
 when you're done.

Tap here to display
the layer panel



Merging Layers

1. Press the         button to display the layer panel (right).
 

2. Put your fnger on a layer, drag over the layers that you'd
       like to merge it with and then release.

Please note:

You can only merge layers with adjacent layers.  If you wish to
merge a layer  with a  non-adjacent  layer,  rearrange the layers
frst.

4. Select 'Yes' when prompted to complete the merge.

Tap here to display
the layer panel



Adding Images

Press the           button to add an image to the active canvas layer:



Animation Pro will display the 'Image Selection' fle manager from which you can select the desired image:

For more information regarding the Animation Pro fle manager, please refer to the 'File Manager' topic (left).



Images are not immediately inserted onto the active canvas layer.  They may be moved, resized, rotated and fipped frst using the 
controls on the 'Paste Options' panel or the 'Rotate' dial at the bottom of the screen:

For more information regarding the 'Paste Options', tap here.

Drag the image
around with your

fnger.

Use two fngers
to reduce and

enlarge the
image.

Choose how the image
should be scaled

when using two fngers
to pinch and zoom.

Change the opacity of
the image.

Rotate the image 90
degrees to the left

or to the right

Flip the image
horizontally or

vertically.

Rotate the image.

Merge the image with
the active canvas layer. Abort.



Distorting the Active Canvas Layer

Press the           button to open the 'Effects' menu:



Select 'Distort' from the 'Effects' menu:



Drag these handles
(there is one at each
corner) to distort the

active canvas
layer.

Tap here to apply
a previous distortion.

Tap here to
reset the distortion.

Abort.

Apply the distortion.

The shape of a
previous distortion.



Blurring the Active Canvas Layer

Press the           button to open the 'Effects' menu:



Select 'Blur' from the 'Effects' menu:



Abort.

Apply the blur efect.

Rotate to select
the strength of
the blur efect.



  Editing Tools Overview

The 'Mouth Creator' provides the
following editing tools:

The brush tool

For painting/
drawing on the
active canvas

layer.

The fll tool

For flling an
area of the

active canvas
layer  with

a given colour.

The eraser tool

For removing
content from

the active
canvas layer.

The selection tool

For selecting
content from

the active
canvas layer for
cut, paste and

copy operations.

The lighten tool

For making parts
of the active
canvas layer

lighter.

The darken tool

For making parts
of the active
canvas layer

darker.

The tint tool

For tinting parts
of the active
canvas layer
with a given

colour.

The shape tool

For adding
shapes to
the active

canvas layer.

The transform tool

For transforming
the content on

the active
canvas layer e.g.
scaling, moving,

rotating.



The Brush Tool

Select the brush tool,         , to start 'painting' on the active canvas layer:

Please note: The brush options will be different when using an Apple Pencil (please see the 'Apple Pencil' topic, left).

Tap here to select a
diferent brush colour

Press this button to
fnely adjust the width

Select the brush style

For brushes that
ease (i.e. taper) in
and/or out, select

the ease-in or
ease-out lengths
by rotating the

dials.

Rotate this dial to set
the width of the brush

Tap here to select the brush tool.

This will present a selection of
diferent brushes as shown on

the next page.



Tap here
to display the
'Fill Options'

panel if another
panel is currently
being displayed.



The Fill Tool

Select the fll tool,         , to fll part of the active canvas layer with a given colour:

Tap here to select a
diferent fll colour

Tap here to select the fll tool.

You may also tap here to display the
'Fill Options' panel if another

panel is currently being displayed.



Filling with Solid Colours

Tap anywhere on the active canvas layer to fll with a solid colour:



Filling with a Linear Gradient

Drag your fnger across the active canvas layer to draw a blue line.  When you release, the area will be flled with a linear gradient,
where:

• The start of the line will be colour 1
• The end of the line will be colour 2
• The angle and length of the line will determine the transition between colour 1 and colour 2 (see the example below)

Please note: You can also tap on the active canvas layer to fll with a gradient.  The gradient will be drawn according
 to the preview on the colour panel.



Filling with a Radial Gradient

Drag your fnger across the active canvas layer to draw a blue line.  When you release, the area will be flled with a radial gradient,
where:

• The start of the line will defne the centre of a circle (colour 1)
• The end of the line will defne the radius of the circle (colour 2)

Please note: You can also tap on the active canvas layer to fll with a gradient.  The gradient will be drawn according
 to the preview on the colour panel.



Fill Options

Tolerance

Animation Pro flls an area until it strikes a colour signifcantly different to the one that you tapped upon.  Just how signifcantly
different that colour needs to be is determined by the 'Tolerance':

• When the tolerance is set to 0%, Animation Pro will fll until it strikes any other colour
• When the tolerance is set to 100%, Animation Pro will fll the entire canvas, regardless of the existing colours found there

Here's an example of an area flled with the tolerance set to 0% and the tolerance set to 80%:

Notice that in the frst image (above), there are 'white' pixels between the green fll and the bounding black line.  This is because
the black line was anti-aliased i.e. grey pixels (they're almost white) exist around the edges of the line to smooth it out.  With the
tolerance set to 0%, Animation Pro doesn't fll these pixels.  At 80% however, it does.

Rotate to set the
tolerance



Preserve Alpha

Sometimes you might wish to change the colour of, say, an existing brush stroke.  This can be a problem if that brush stroke was
anti-aliased, please see below:

It  is  possible  to  produce  a  better  result  in  this  situation  by
turning the 'Preserve Alpha' switch on.  Animation Pro will then
fll  the anti-aliasing pixels  (the grey ones,  above)  with  the fll
colour whilst preserving their original opacity (alpha channel):

Grey pixels exist
around the edges
of this anti-aliased

brush stroke

Filling with a high
enough tolerance

to cover the
grey pixels causes
the end result to

look 'jagged'



Replace Colour

When Animation Pro flls an area, it actually places the new colour 'over the top' of the colours already there (based upon the
tolerance).  So, if the new colour is semi-transparent, you'll actually be able to see the previous colour showing through from
underneath:

To  replace  the  existing  colours  instead,  turn  the  'Replace
Colour' switch on.  Tapping on the image (shown above) will
then yield the following result:

A red colour has been
selected with
40% opacity



Fill Void

When setting the tolerance high enough to completely fll a void (an uncoloured part of the active canvas), you can end up with
'jagged' edges as shown below:

Turn on the 'Fill Void' switch to improve the end result:

Please note: 

This feature only works when flling voids (uncoloured parts of
the active canvas).

'Jagged' edges



The Eraser Tool

Tap on the eraser tool,         , to remove content from the active canvas layer. 

Use this panel to
set the colour
and opacity
of the eraser

cursor.

Tap here to choose the
eraser tool.

You may also tap here
to display the

'Eraser Options'
panel if another

panel is currently
being displayed.

Choose the size
of the eraser.

Move your fnger
(or the Apple pencil,
if selected) across

the canvas to remove
content from the

active layer.



The Transform Tool

Tap on the transform tool,         , to quickly move, rotate, scale, fip and set the opacity of the active canvas layer. 

For more details on how to move, rotate, scale and fip the active canvas layer, please see 'Paste Options' – it works the same
way!

Tap here to choose the
transform tool.

Use these buttons
to accept or reject

your changes.

Drag the contents of
the active canvas
layer around with

your fnger.

Use two fngers to
enlarge or shrink

the layer.



The Selection Tool

Tap on the selection tool,         , to perform select, cut, copy and paste operations:

Please note:  The canvas will appear slightly 'washed out' when this tool is chosen.  This allows your selections to be seen.

Tap here to choose the
selection tool.

You may also tap here
to display the

'Selection Options'
panel if another

panel is currently
being displayed.



Selecting Content

Selecting content from the active canvas layer is easy.  Choose a 'Selection Size' using the dial at the bottom of the screen and
then drag your fnger across the screen to select the desired content:

Alternatively,
tap here to select
everything on the

active canvas layer

Make sure the selection
mode is set to 'Add'

This button will
turn your selection

'inside-out'

Rotate this dial to set
the width of the selection



Deselecting Content

Perhaps you've selected a little bit too much?  Change the 'Selection Mode' to 'Subtract' and paint over the part of the selection
that you'd like to remove:

Please note:  You can also press the 'Clear Selection' button on the 'Selection Options' panel to remove the entire selection.



Cut

Once you've selected part of the active canvas layer, you can press the         button to perform a 'Cut' operation.  This will
remove the selected content and place it in the 'Clipboard' for later use:

Please note:  

The selection will be retained until you press the 'Clear Selection' button at
the bottom of the 'Selection Options' panel, even if you change tools.

The canvas will look
like this after the

selection has
been removed

Press to clear the
selection

The content has
been cut from the

active canvas layer
and placed in the

clipboard



Copy

Once you've selected part of the active canvas layer, you can press the         button to perform a 'Copy' operation.  This will copy
the selected content and place it in the 'Clipboard' for later use:

Please note:  

The selection will be retained until you press the 'Clear Selection' button at the bottom of the 'Selection Options' panel, even if
you change tools.

Press to clear the
selection

The content has
been copied from the
active canvas layer
and placed in the

clipboard



Paste

Once content has been cut or copied from the active canvas layer and placed into the Animation Pro clipboard it can be 'pasted'
back onto the active canvas layer (which, of course, can be a totally different layer than the one you started with; in fact, given that
the clipboard is shared across projects, it can be a totally different layer in a different project):

To paste content from the clipboard, press the           button:

A 'Paste Options' panel will
be  displayed.   This  allows
the  contents  of  the
clipboard  to  the  rotated,
scaled,  fipped etc.  prior  to
being pasted onto the active
canvas  layer  (see  next
pages).

Please note:

Many of the other functions
within the mouth creator will
be disabled until you dismiss
the  'Paste  Options'  by
pressing  either  the  green
tick or the red cross button
at the bottom of the panel.



Paste Options

Scaling the Pasted Content

The scaling modes control  what happens when you use
pinch-to-zoom.   They  allow  the  pasted  content  to  be
scaled in three ways (see right):

Please note:  You may press the 'Reset' button located 
     under the scaling mode buttons to reset

      any scaling adjustments.

2. Height only 3. Both width and height

1. Width only



Rotating the Pasted Content

Use the           and          buttons to rotate the pasted contents 90 degrees to the left or 90 degrees to the right.

You may also use the 'Rotate' the pasted content using two fngers (or by using the dial at the top of the screen, as shown
above).

Rotate 90 degrees
left

Rotate 90 degrees
right

Reset the
rotation

Press this button to 
make a fne adjustment



Flipping the Pasted Content

Use the           and          buttons to fip the pasted contents horizontally or vertically.

Flip horizontally

Flip vertically



Setting the Opacity of the Pasted Content

Rotate the opacity dial (see below) to set the opacity of the pasted content:



Moving the Pasted Content

You may move the pasted content about by dragging it with your fnger:



Committing a Paste Operation

Once you've fnished scaling, rotating and fipping etc. the pasted content, press the       button at the bottom of the 'Paste
Options' panel to commit it to the active canvas layer.

This will merge the pasted contents with any content already on that layer.

Press this button to
merge the pasted

content with the contents
of the active canvas

layer

Press this button to
abort the paste

operation



The Lighten Tool

Select the lighten tool,         , to 'lighten' part of the active canvas layer:

Use this dial to
set the strength
of the 'lighten'

efect

Press this button to
fnely adjust the width

When you drag your
fnger over the 

canvas, the colours
will be made

lighter

Rotate this dial to set
the width of the brush

Tap here to select the
lighten tool.

You may also tap here
to display the

'Lighten Options'
panel if another

panel is currently
being displayed.



The Darken Tool

Select the darken tool,         , to 'darken' part of the active canvas layer:

Use this dial to
set the strength
of the 'darken'

efect

Press this button to
fnely adjust the width

When you drag your
fnger over the 

canvas, the colours
will be made

darker

Rotate this dial to set
the width of the brush

Tap here to select the
darken tool.

You may also tap here
to display the

'Darken Options'
panel if another

panel is currently
being displayed.



The Tint Tool

Select the tint tool,         , to tint part of the active canvas layer with a given colour:

The 'Tint Colour
Options'.

Select a colour
for the tint operation.

You may also tint
with gradients.

Press this button to
fnely adjust the widthWhen you drag your

fnger over the 
canvas, the colours

will be tinted with the
selected colour

Use this dial to
set the strength

of the tint
operation

Rotate this dial to set
the width of the brush

Tap here to select the
tint tool.

You may also tap here
to display the

'Tint Colour Options'
panel if another

panel is currently
being displayed.



The Shapes Tool

You can add shapes to the active canvas layer using by pressing the          button at the top of the screen.

This will display the 'Shape Options' panel:

Tap here to select a
diferent shape colour

Tap here to select the
shapes tool.

You may also tap here
to display the

'Shape Options'
panel if another

panel is currently
being displayed.



Adding Circles or Ovals

Press the          button on the 'Shape Options' panel to add a circle or oval to the active canvas layer:

Please note:

Circles and/or ovals may be
dragged around the canvas
using one fnger.

Drag this handle to 
change the height
of the circle/oval

Drag this handle to 
change the width

and/or height of the
 circle/oval

Drag this handle to 
change the width
of the circle/oval

Choose whether
the circle/oval is flled

with the selected
colour or not

Select the colour of
the circle/oval

Use these controls
to rotate the
circle/oval

Merge the circle/oval
with the content on

the active canvas layer
Abort

Drag this handle to
resize the circle/oval

without changing
its current aspect

ratio

Adjust the thickness
of the circle/oval



Adding Squares or Rectangles

Press the          button on the 'Shape Options' panel to add a square or rectangle to the active canvas layer:

Please note:

Squares  and/or  rectangles
may be dragged around the
canvas using one fnger.

Drag this handle to 
change the height of
the square/rectangle

Drag this handle to 
change the width

and/or height of the
 square/rectangle

Drag this handle to 
change the width of the

square/rectangle

Choose whether the
square/rectangle is flled

with the selected
colour or not

Select the colour of
the square/rectangle

Use these controls
to rotate the

square/rectangle

Merge the square/
rectangle with the content on

the active canvas layer
Abort

Choose whether the
corners of the square/
rectangle should be

rounded or not

Drag this handle to
resize the square/
rectangle without

changing
its current aspect

ratio

Adjust the thickness
of the square/rectangle



Adding Lines

Press the          button on the 'Shape Options' panel to add a line to the active canvas layer:

Please note:

Lines  may  be  dragged
around  the  canvas  using
one fnger.

Drag this handle to 
move the end point

of the line

Drag this handle to 
move the end point

of the line

Select the colour of
the line

Use these controls
to rotate the

line

Merge the line
with the content on

the active canvas layer
Abort

Choose whether the
ends of the 

line should be
rounded or not

Adjust the thickness
of the line



Adding Curves

Press the          button on the 'Shape Options' panel to add a curve to the active canvas layer:

Please note:

Lines  may  be  dragged
around  the  canvas  using
one fnger.

Drag this handle to 
move the end point

of the curve

Drag this handle to 
move the end point

of the curve

Select the colour of
the curve

Use these controls
to rotate the

curve

Merge the curve
with the content on

the active canvas layer
Abort

Choose whether the
ends of the 

curve should be
rounded or not

Choose whether the
inside of the curve

should be flled with
the selected colour

Drag this handle to 
bend the curve

Drag this handle to 
bend the curve

Adjust the thickness
of the curve



Undo/Redo

Invariably you are going to do something wrong – paint something you shouldn't  have, erase something by mistake or tell
someone that they actually do look fat.  Well, with the exception of that last example, the 'Mouth Creator' does give you some
scope for rectifying your mistakes:

Press this button to
roll back all of the

changes made to the
currently selected mouth.

This will revert the
mouth back to its last

saved state

Press this button
to undo up to 99

changes made to the
currently selected
mouth.  The little
green number will
indicate how may

'undos' are possible.

Press this button
to redo up to 99

undos made to the
currently selected
mouth.  The little
green number will
indicate how may

'redos' are possible.



Testing a Mouth

So you've drawn your 12 mouth shapes and now you'd like to see your mouth in action.  Press the          button at the bottom-
left of the screen to test your mouth:



Animation Pro will open the 'Test Mouth' panel.  Use the controls on this panel to test your mouth and then press the            
       button when you're done.

Press this button
to see the mouth

lip-synching.

This will play a sample
audio fle if you haven't

recorded your own.

Press this button
to stop the

playback of audio
and lip-synching.

Turn this dial to
adjust the preview

frame-rate.

Lip-synching works
best when the frame
rate is 8 frames per
second or higher.

Press this button
when you've fnished
testing your mouth.

Press this button
to record your own

sound for the mouth
to lip-synch.

Press this button to
set the microphone

gain prior to
recording



Saving the Currently Selected Mouth

A green tick,          , will appear over the currently selected mouth whenever changes have been made.

Press the green tick to save all of your changes to that mouth.  



Exporting Mouths

Once you've created the individual mouth shapes, the next step is to save them as an 'Animation Pro Mouth' (.APM) fle for use in
your animations.  The mouth creator can produce '.APM' fles containing the 12 images at either 250x250 pixel (standard) or
500x500 pixel (high) resolutions (800 x 800 on the 12.9” iPad Pro).

Press the            button at the top of the screen to open the 'Output' menu:

Choose this option
to save the mouth at
a standard resolution

of 250x250 pixels.

Choose this option
to save the mouth
at a resolution of
500x500 pixels

(800 x 800 on the 
12.9” iPad Pro).



Other Output Options

The 'Output' menu (press the      button at the top of the screen to open the 'Output' menu) contains a multitude of other options:

Choose this option to generate
a 250x250 pixel (.APM) mouth fle, 
placing it in an email, together with

a preview image for sharing
with others.

Choose this option to generate
a 500x500 pixel (.APM) mouth fle
(800 x 800 on the 12.9” iPad Pro), 
placing it in an email, together with

a preview image for sharing
with others.

Choose this option to generate
a 250x250 pixel (.APM) mouth fle.

Animation Pro will display the
iOS sharing popover so that

the mouth may be shared with
other apps.

Choose this option to generate
a 500x500 pixel (.APM) mouth fle
(800 x 800 on the 12.9” iPad Pro).

Animation Pro will display the
iOS sharing popover so that

the mouth may be shared with
other apps.

Choose this option to save the
currently selected mouth as

an image.

Please note: This will open
the 'Adjust Size' popover

(see next page).

Same as above.  The mouth's
canvas, however, will be trimmed
to remove empty space around

the image.

Choose this option to share the
currently selected mouth as
an image.  Animation Pro will

display the iOS sharing popover so
that the image may be shared with

other apps.

Same as above.  The mouth's
canvas, however, will be trimmed
to remove empty space around

the image.



Cropping and Reducing the Image Size

Whenever you save an image, Animation Pro will display the 'Adjust Size' popover.  This allows the image to be cropped and/or
resized prior to it being saved to your iPad's storage:

Save the image

Exit without saving



Reduce the size/resolution of your image by rotating the 'Width' and 'Height' dials at the bottom of the screen.  Adjusting one dial
will automatically adjust the other where the 'Maintain Aspect Ratio' switch is turned on.  Turn off the 'Maintain Aspect Ratio'
switch if you wish to adjust the width and height of the image independently.

Press to reset the 
image back to its

original state

Save the image

Exit without saving

Add the size selection
to the clipboard

Retrieve the size from 
the clipboard



Press the 'Crop' button at the top of the 'Adjust Size' popover to display the blue 'cropping' handles (please see below).  Drag
these handles around with your fnger to select part of your image (as indicated by a black bounding rectangle).  When you're
fnished, press the 'OK'' button to crop the image to the black bounding rectangle or 'Cancel' to abort without making any
changes.

The bounding black
rectangle indicates the
portion of the image
that will be retained Drag this handle to

change the width of
the rectangle

Drag this handle to
change the height of

the rectangle

Drag this handle to
change the width and/or
height of the rectangle

Drag this handle to
change the size of

the rectangle without
altering its aspect

ratio

Press OK to complete
the cropping operation

Press Cancel to abort
the cropping operation

Press to reset the 
image back to its

original state

Add the crop settings
to the clipboard

Retrieve the crop settings
from the clipboard



When you're done resizing and cropping the image, press the           button at the bottom of the 'Adjust Size' popover to save the
image.  The image will be saved under the 'User Images' category within the 'Image Selection' fle manager.

Please note:   The            button will be disabled whilst cropping your image.

Alternatively, press this
button to exit without

saving the image



The Cursor

Animation Pro can display a cursor for any of its painting/selection tools.  This will allow you to see where the painting/selection will
occur as well as the size of the 'brush':

The cursor

Use this switch to
turn the cursor

on or of



Antialiasing

iPad images are composed of a grid of pixels (picture elements).  So drawing a line across an image can result in jagged edges as
shown below:

When zooming in
on an image, the
edges of the line

can look very jagged.



The process of antialiasing the line adds, in this case, additional grey pixels which have the effect of smoothing out the jagged
edges:

Additional pixels are
added to smooth out

the jagged edges



Turning Antialiasing On and Of

Whilst antialiasing produces much smoother lines, brush strokes, circles etc., sometimes it can be advantageous to turn it off.
You may be, for example, wanting to paint individual pixels.  Perhaps you're going for that retro 8-bit look!  So Animation Pro
allows antialiasing to be turned on or off at any point in time (changing the setting will not affect any content already on the
canvas).

Use this switch to
turn antialiasing on

and of



Mouth Creator Options

Press the           button at the top of the screen to open the 'Options' menu:

Press this button to
select a background

colour.

This can be useful if
you are trying to draw

something white.

Please note that this
colour will not be
rendered in your
exported images.

Press this button to
generate an onion-skin

from the currently
selected mouth.

This can be useful where
you are changing a

mouth but wish to see
what it used to look

like.

Rotate this dial to
set the opacity of
the onion-skin.

Remove the onion-skin.

Did I just repeat myself?

Select a left-handed
or right-handed

display.



Copying Mouth Shapes

In a lot of cases, each mouth shape will be a simple variation of another.  It would thus be very time consuming to draw each
shape from scratch or copy the layers from one mouth shape to another one by one.  Fortunately, copying a mouth shape is as
simple as dragging it, and dropping it, over one of the other shapes:



Setting an Onion Skin

You can use the 'Options' menu to set the currently selected mouth as an onion skin.  However, you can easily set any of the
other mouth shapes as an onion skin by dragging them onto the canvas:


